T.C.
MİLLİ EĞİTİM BAKANLIĞI

BİLİŞİM TEKNOLOJİLERİ

YABANCI DİLDE YAZILIM VE AĞ KAVRAMLARI
222YDK120

Ankara, 2012
Bu modül, mesleki ve teknik eğitim okul/kurumlarında uygulanan Çerçeve Öğretim Programlarında yer alan yeterlikleri kazandırmaya yönelik olarak öğrencilere rehberlik etmek amacıyla hazırlanan bireysel öğrenme materyalidir.

Millî Eğitim Bakanlığına ücretsiz olarak verilmiştir.

PARA İLE SATILMAZ.
CONTENTS

AÇIKLAMALAR ........................................................................................................... iii
INTRODUCTION ...................................................................................................... 5
LEARNING ACTIVITY–1 ........................................................................................ 7
1. SOFTWARE TERMS ............................................................................................ 7
   1.1. Operating System Tools ............................................................................... 7
       1.1.1. General Terms ..................................................................................... 7
       1.1.2. System and Maintenance ................................................................. 8
       1.1.3. Control panel .................................................................................... 10
       1.1.4. Windows .......................................................................................... 11
   1.2. Packet Program Terms ............................................................................... 12
       1.2.1. Word Processer Terms .................................................................... 12
       1.2.2. Electronic Table Terms ................................................................. 17
       1.2.3. Presentation Software terms and definitions .................................... 19
   1.3. Programming Terms .................................................................................... 36
       1.3.1. General Terms .................................................................................. 36
APPLICATION ACTIVITY ......................................................................................... 39
MEASURING AND EVALUATION .............................................................................. 41
LEARNING ACTIVITY-2 .......................................................................................... 42
2. INTERNETTERMS ............................................................................................... 42
   2.1. General Terms .......................................................................................... 42
   2.2. E-mail Terms ........................................................................................... 47
APPLICATION ACTIVITY ......................................................................................... 51
MEASURING AND EVALUATION .............................................................................. 53
LEARNING ACTIVITY-3 .......................................................................................... 54
3. NETWORK TERMS ............................................................................................... 54
   3.1. General Definitions ................................................................................... 54
   3.2. Network Hardware Components .............................................................. 57
APPLICATION ACTIVITY ......................................................................................... 59
MEASURING AND EVALUATION .............................................................................. 61
MODULE EVALUATION ............................................................................................ 62
ANSWER KEY ........................................................................................................ 64
RESOURCES ........................................................................................................... 66
## MODÜLÜN ADI
Yabancı Dilde Yazılım Ve Ağ Kavramları

## MODÜLÜN TANIMI
Bu modül; yazılım ve ağ kavramlarının yabancı dildeki karşılıklarını kullanma temel bilgi ve becerilerin kazandırıldığı bir öğrenme materyalidir.

## SÜRE
40/24

## ÖNKOŞUL
Bu modül için ön koşul yoktur.

## YETERLİK
Yazılım ve ağ kavramlarının yabancı dildeki karşılıklarını kullanmak

### MODÜLÜN AMACI

**Genel Amaç**
Öğrenci, bu modül ile gerekli ortam sağlandığında; ihtiyaç duyulan yazılım ve ağ kavramlarının yabancı dildeki karşılıklarını kullanabileceği.

**Amaçlar**
1. Tekniğine uygun olarak yazılım kavramlarının yabancı dildeki karşılıklarını okuyup kullanabileceği.
2. Tekniğine uygun olarak web kavramlarının yabancı dildeki karşılıklarını okuyup kullanabileceği.
3. Tekniğine uygun olarak ağ kavramlarının yabancı dildeki karşılıklarını okuyup kullanabileceği.

### EĞİTİM ÖĞRETİM ORTAMLARI VE DONANIMLARI

**Ortam:** Yabancı dil laboratuarı.

**Donanım:** Projeksiyon cihazı.

### ÖLÇME VE DEĞERLENDİRME
Modül içinde yer alan her öğrenme faaliyetinden sonra verilen ölçme araçları ile kendinizi değerlendirireceksiniz. Öğretmen modül sonunda ölçme aracı (çoktan seçmeli test, doğru-yanlış vb.) kullanarak modül uygulamaları ile kazandığınız bilgi ve becerileri ölçerek sizi değerlendirecektir.
Dear Student;

Nowadays, knowing of foreign language is a fact that cannot be ignored. And everyone knows this fact. It has become an important part of people's daily lives. If people know a foreign language, they can find a job easily. In addition, It is possible to achieve better wages.

We live in the time period described as the information age. The information age has accelerated the development of technology. In addition, information life and of time the validity is short increasingly. Therefore, the information obtained must be kept up to date. At this point, you need to know a foreign language in order to be a step ahead.

Today, English has been adopted by the whole world and was accepted as a world language. All issued information are translated into English and are published.

The computing sector is developing very fast. The highest using of technological developments has become an industry branch. Therefore, If people work in this area, they need to know to Technical English.

This module is about information technology in the computing sectors. This module includes English equivalents and usage patterns of the basic definition and terms. With this module you will follow the developments in the field of information technology and will have the knowledge of technical English.
AIM

Students will be able to make the software definitions according to the technique.

SEARCH

- Research the basic definitions and terms about software.
- Prepare a report of your findings.
- Make a presentation to your teacher and your friends in your classroom.

1. SOFTWARE TERMS

1.1. Operating System Tools

1.1.1. General Terms

- Operating System
  
  Operating system is a software communicating with the user in a computer system that allows allocation of hardware and software resources in an equitable manner.

- Open source Operating System
  
  Source codes are publicly available, distribution for free and free of charge.

- License
  
  It is a text of a contract protecting the rights of software producers and determines the terms of use.

- Setup
  
  The general name given to the set up files of software.

- Partition
  
  It is the allocation of a harddisk to ensure the efficient use of hardisk while installing operating system.
- **Formatting**
  Erasing all information in a hard drive while installing an operating system.

- **Driver**
  All of the files needed to introduce the hardware units to the operating system itself.

- **Version**
  The variations of a software announced in different periods.

### 1.1.2. System and Maintainance

- **System Restore**
  Troubleshooting by restoring the system files and programs of a PC to a previous, trouble-free configuration.

- **Defragmentation**
  Defragmentation is the process of combining the broken data in a unit.

![Picture 1.1: Disk Defragmentation](image)

- **Disk Controlling / Checking**
  The process of error control in driver or drivers.

- **Disk Cleanup**
  Used to reduce the unnecessary files in a hard drive and make the PC work faster by providing space in hard drive.
A database including important information about system hardware, installed programs, settings and the profiles of all user accounts in PC.

Provides installation, display and management of all devices connected to PC.
1.1.3. Control panel

Is the central location for all your operating system configuration needs. Control Panel is the Category view and that there are eight categories. You can display the Control Panel in either a large or a small icon view.

1.1.3.1. System and Security

Contains all the tools that you’ll use to perform system, administrative, and security-related tasks.
1.1.3.2. Network and Internet Control Panel

Allows you to configure and control the way that the operating system works.

1.1.3.3. Hardware and Sound Control Panel

The Hardware and Sound category is the third one in the Control Panel and contains all the tools that you’ll use to add and remove printers and other hardware, change system sounds, configure AutoPlay, manage power, update drivers, and more.

1.1.3.4. Programs

The Programs category is the fourth one in the Control Panel and contains all the tools that you’ll use to uninstall programs or Windows features, manage gadgets, and more.

1.1.3.5: User Accounts and Family Safety

The User Accounts and Family Safety category is the fifth one in the Control Panel and contains all the tools that you’ll use to change user account settings and passwords, set up parental controls, manage credentials, and more.

1.1.3.6: Appearance and Personalization Control Panel

The Appearance and Personalization category is the sixth one in the Control Panel and contains all the tools that you’ll use to change the appearance of desktop items, apply various desktop themes and screen savers, customize the Start menu or Taskbar, and more.

1.1.3.7. Clock, Language, and Region

The Clock, Language, and Region category is the seventh one in the Control Panel and contains all the tools that you’ll use to change date, time, language, numbers, currency, and more.

1.1.3.8. Ease of Access

The Ease of Access category is the eighth one in the Control Panel and contains all the tools that you’ll use to adjust your computer settings for vision, hearing, and mobility as well as configure speech recognition to control your computer with voice commands.

1.1.4. Windows

Whenever you open a program, file, or folder, it appears on your screen in a box or frame called a window (that’s where the Windows operating system gets its name). Because windows are everywhere in Windows, it’s important to understand how to move them, change their size, or just make them go away.
1.1.4.1. Parts of a window

Although the contents of every window are different, all windows share some things in common. For one thing, windows always appear on the desktop—the main work area of your screen. In addition, most windows have the same basic parts.

![Parts of a typical window](image)

**Picture 1.6: Parts of a typical window**

1.2. Packet Program Terms

1.2.1. Word Processor Terms

A program designed to create, edit and print text based documents including: letters, memos, faxes, and reports etc. A word processor enables you to save your documents on the computer and edit and update them later. You can see more definitions.

- **Text**

  Another name for alphabetical data that was entered.

  ![Text](image)

  **Picture 1.7: Text**

- **Character**

  Any letter, number, or symbol typed on the keyboard.
Document

Anything produced on a word processing program.

Cursor

A highlighted mark (sometimes blinking) on the screen that indicates the user's location.

Arrow Keys

Keys used in place of the mouse to move the cursor to a new location.

Menu Bar

The line at the top of the screen that gives you your different choices.
➢ **Title Bar**

The line near the top of the screen that gives the name of your file.

➢ **Scroll**

To move text up and down and left and right on the screen.

➢ **Font**

It is the style of writing.

![Font Selection](Picture 1.11: Font)

➢ **Edit**

To make changes to a document.

➢ **Insert**

To add new text into already existing text.

➢ **Delete**

To remove or erase.

➢ **Cut and Paste**

To highlight text and move it to another location.

➢ **Copy and Paste**

To highlight text, leave it where it is, and also put a copy of it in another location.
- **Tab**
  Used to indent text in a line; can also be used to set-up columns in a document.

- **Hardcopy**
  Output from a computer that you can touch—(Ex: output from a printer or plotter).

- **Softcopy**
  Output from a computer that you can see or hear, but can not touch.

- **Alignment**
  Use a great deal in word processing determines the distance or position from a determined edge.

  ![Image](image)

  **Picture 1.12: left, center, right, justify**

- **Bold**
  Text formatting – bold will make the text fuller and darker.

- **Break**
  Used in word processing to create various layouts in a document. It can be within a page or between pages. Common breaks used are page breaks or column breaks. You insert a break under the insert command.

- **Column breaks**
  Forces the start of a new column when your document is formatted into columns. This break will form wherever your insertion point is located and move the document from that point to the top of the next column.

- **Date**
  Dates can be inserted in a word processor by going to **Insert – Date and Time** will bring up a screen of different formats of the present date and time. There is a check box for this date and time to automatically update every time the document is open.

- **Footer**
  Footers are areas in the bottom margins of each page in a document. Go to **View – Header and footer**. The footer will appear as a dotted area on the bottom of the page. Footer will gray out when you return to main document.
Header

Headers are areas in the top margins of each page in a document. Go to View → Header and Footer. The header will appear as a dotted area on the top of the page. Headers will gray out when you return to main document.

Italic

Text formatting – bold will make the text fuller and darker.

Justify Formatting

Used in Word-processing. Justify is to adjust horizontal spacing so that the text is aligned evenly along both the left and the right margins. Justifying text creates a sooth edge on both sides. Select text and press the Justify button.

Landscape

The page can be set the orientation of the page to print in Portrait or Landscape. Portrait is the default and is like portraits in an art museum. Landscape is not the default and must be selected. It is like a painted landscape.

Margins

Margins are the blank areas outside the print area on the edges of the document. To change them go to File → Page Setup → Margin tab. Usually change margin for Top, Bottom, Left, and Right margin.

Paste

Information that has been cut or copied to the clipboard can be placed in another location.
- **Page breaks**

Used layout a pages so the next sections starts on a new page.

- **Replace**

Change existing text to something else. Go to Edit—Replace. Then type in what you want to find and what you want to replace it with.

- **Thesaurus**

A tool used to replace a word with another word that is similar.

- **Window Menu**

When more than one file is open, you can switch between files by using the window command on the menu bar.

- **Wrap text**

Sometime called word wrapping. It allows text to surround an object in a document. It can be used in several ways, but you can choose from these Wrapping Styles:

![Wrapping styles](Picture 1.15: Wrap Text)

Select picture and go to **Format—Pictures—Layout** Tab, select picture and Picture toolbarmay appear if turned on in toolbars, select picture and right mouse click and choose **Format Picture** and choose **Layout Tab**.

### 1.2.2. Electronic Table Terms

- **Cell**

A box formed by the intersection of a row and column in a worksheet or a table, in which you enter information.

- **Cell Reference**

The set of coordinates that a cell occupies on a worksheet. For example, the reference of the cell that appears at the intersection of column B and row 3 is B3.
- **Column (Field)**
  A set of vertical cells

- **Conditional Format**
  A format, such as cell shading or font color, that Excel automatically applies to cells if a specified condition is true.

- **Copy Area**
  The cells that you copy when you want to paste data into another location. After you copy cells, a moving border appears around them to indicate that they've been copied.

- **Fill Handle**
  The small black square in the lower-right corner of the selection. When you point to the fill handle, the pointer changes to a black cross.

- **Filter**
  To display only the rows in a list that satisfy the conditions you specify. You use the AutoFilter command to display rows that match one or more specific values, calculated values, or conditions.

- **Formula**
  A sequence of values, cell references, names, functions, or operators in a cell that together produce a new value. A Formula always begins with an equal sign (=).

- **Formula Bar**
  A bar at the top of the Excel window that you use to enter or edit values or formulas in cells or charts. Displays the constant value or formula stored in the active cell.

- **Function (Office Excel)**
  A prewritten formula that takes a value or values, performs an operation, and returns a value or values. Use functions to simplify and shorten formulas on a worksheet, especially those that perform lengthy or complex calculations.

- **Merged Cell**
  A single cell that is created by combining two or more selected cells. The cell reference for a merged cell is the upper left cell in the original selected range.
Name Box

Box at left end of the formula bar that identifies the selected cell, chart item, or drawing object. To name a cell or range, type the name in the Name box and press ENTER. To move to and select a named cell, click its name in the Name box.

Operator

A sign or symbol that specifies the type of calculation to perform within an expression. There are mathematical, comparison, logical, and reference operators.

Print Area

One or more ranges of cells that you designate to print when you don’t want to print the entire worksheet. If a worksheet includes a print area, only the print area is printed.

Range

Two or more cells on a sheet. The cells in a range can be adjacent or nonadjacent.

Row (Record)

A set of vertical cells

Scroll Lock

With scroll lock turned on, the arrow keys scroll the active sheet rather than make a different cell active. To turn scroll lock off or on, press the SCROLL LOCK key.

Select

To highlight a cell or range of cells on a worksheet. The selected cells will be affected by the next command or action.

1.2.3. Presentation Software terms and definitions

3-D Chart

3-D charts are any charts that have a three-dimensional appearance, that is, height, width, and depth.

3-D Surface Chart

3-D surface charts show relationships between large amounts of data that would otherwise be difficult to see.
➢ **Action Buttons**

Action buttons are buttons that you create in a presentation that perform an action when you click them. You can have an action button start a video, give information, play a sound, or move to a hyperlink.

➢ **Animation Effects**

Animation effects are builds, movement, and other special effects that can be applied to objects and text to add interest and variety to a presentation.

➢ **Animation Icon**

In Slide Sorter view, the animation icon is displayed under all slides that have animation applied to them.

➢ **Animation Preview**

Use the Animation Preview command on the Slide Show menu to preview the animation effect in the thumbnail.

➢ **Animations**

Animations are effects that allow you to reveal the points on a slide one by one.

➢ **Application Window**

The PowerPoint application window holds the current presentation. It consists of the default toolbars, but many of the tools and menu items are not available if a presentation is not open.

➢ **Audience Handouts**

Audience handouts are small, printed versions of your slides that can contain an area for notes. They are usually printed and distributed to the audience.

➢ **AutoClipArt**

Use the AutoClipArt command to begin a concept keyword search of your slideshow. PowerPoint searches your slideshow for keywords that relate to the keywords associated with clip art images in the Clip Gallery.

➢ **AutoShapes**

AutoShapes are the shapes that are drawn automatically when you click the button representing the shape, and drag the drawing tool to the desired size.
AutoContent Wizard

The AutoContent Wizard guides you through a number of formatting selections that will help you develop a clear, professional style for your presentation.

AutoLayouts

AutoLayouts are slide layouts that have ready-made placeholders for titles, text, and objects such as clip art, graphs, and charts.

Background

The Background dialog box provides various options that let you change the background look of a single slide or every slide in the presentation.

Background Fill

The Background fill options, located in the Background dialog box, allow you to change the color, shading, pattern, texture, and picture of slide backgrounds.

Background Items

Background items are any objects that are added to the Slide Master that appear on all of the slides in a presentation that follow the Slide Master's formatting. Any object on the master, other than the master title and text, is considered to be a background item, including art, logos, the date and time, slide numbers, and the presentation name.

Basic Shapes

Basic shapes are shapes that can be created by simply clicking the appropriate Drawing tool, then clicking and dragging it to form that shape.

Blank Presentation

The Blank Presentation option opens PowerPoint's default presentation. You can design or save any presentation as the default so that presentation will open every time you select the Blank Presentation option.

Branching Slides

Branching slides provides one way to make one presentation to suit different audiences. Branching allows you to have two or more slide shows within a single slide show where you can run each when appropriate.

Bring Forward

The Bring Forward option on the Order submenu allows you to send objects forward one level or layer of a slide at a time.
- **Bring To Front**

  The Bring to Front option on the Order submenu allows you to send objects all the way to the front or top level or layer of a slide.

- **Bubble Chart**

  Bubble charts are a type of chart that show the relationships between the chart values by the size of the circles.

- **Build**

  A build is a feature that is formed when bullets or objects appear one at a time with animated effects.

- **Builds**

  Builds are effects that allow you to reveal the points on a slide one by one.

- **Bullets**

  Bullets are dots, arrows, or other symbols used to identify items in a list.

- **Case**

  Case determines whether letters are capital (uppercase) or non-capital (lowercase.) This option allows you to change the case of a selected letter, letters, or text.

- **Cell**

  A cell is the intersection of a row and a column. Each cell is identified by the column letter and the row number, such as A1.

- **Chart**

  A chart is a diagram of relationships or comparisons between two or more things.

- **Clip Art**

  Clip art is a collection of professionally designed images that can be inserted into a presentation.

- **Clip Art Categories**

  Clip art categories in the ClipArt Gallery are topics that group similar types of clip art.
- **Close**

  Use the Close command to exit an active presentation without leaving the application.

- **Column Chart**

  Column charts show a variation over a period of time, or they show a comparison between items.

- **Columns**

  Columns are the vertical divisions of a datasheet that are identified by letters.

- **Common Tasks Toolbar**

  The Common Tasks toolbar appears as a floating toolbar on the PowerPoint screen. It consists of options that allow you to quickly access commonly used dialog boxes, and these options change depending on your current process.

- **Crop Tool**

  The Crop tool allows you to alter an object by hiding or cutting portions of it.

- **Data**

  Data is related information that is grouped and manipulated by an application.

- **Data Labels**

  Data labels provide additional information about the sections of a chart, such as values, names of data series or categories, percentages, or a combination of these.

- **Data Series**

  A data series is a group of figures about one item. For instance, if you are charting the sales figures for cogs and widgets for the last year, all of the cog figures make up the cog data series.

- **Datasheet**

  Datasheets contain related information or data to be analyzed.

- **Doughnut Chart**

  Doughnut charts show the proportions of parts to a whole and can show more than one series of data.
- **Drag-and-drop**
  
  Drag-and-drop is clicking the mouse button and holding it on a selected item, then dragging the item to a new location and releasing the mouse button.

- **Drag-select**
  
  Use drag-select to select text. With the I-beam mouse pointer, click before the text you want to select, and drag to the end of the text you want to select. The selected text appears highlighted (with a dark background) and is ready to be changed.

- **Drawing Toolbar**
  
  The Drawing toolbar is located on the left side of the PowerPoint window, and contains buttons that provide quick access to commonly used drawing tools and functions.

- **Drawing Tools**
  
  Drawing tools include AutoShapes, lines, and other options that make it easy to draw, color, or position presentation objects.

- **Elapsed Time**
  
  The elapsed time for the slides that have been rehearsed is displayed on the left side of the Rehearsal Timer.

- **Exit**
  
  Use the Exit command to close all active presentations as well as the application.

- **Fill Effects**
  
  Select Fill Effects in the Background fill section of the Background dialog box to choose from a variety of effects, including textures and patterns.

- **Find**
  
  The Find option allows you to locate every instance of a specified word or words.
- **Floating Toolbar**

  A floating toolbar is any toolbar that appears as a box in the working screen area. Any toolbar can be made into a floating toolbar by simply clicking-and-dragging the toolbar to the working screen area.

- **Font Embedding**

  Font embedding saves TrueType fonts in a presentation so text will be properly displayed on other computers.

- **Font Size**

  A font size is the size of a font measured in points. The more points there are in a font, the larger it will appear. There are 72 points to an inch.

- **Footer**

  A footer is any information located in the bottom margin of a document that is repeated on every page or every other page, such as page numbers or file names.

- **Formatting Toolbar**

  The Formatting toolbar is located beneath the Standard toolbar, and contains buttons that provide quick access to commonly used formatting tools and options for the application.

- **Graphical Builds**

  A graphical build is a series of objects that are placed on a slide one at a time to create an animated effect.

- **Graphics**

  Graphics are images such as clip art, word art, graphs, and charts.

- **Handouts**

  Handouts are smaller versions of your slides that are printed and can be distributed to the audience.

- **Header**

  A header is any information located in the top margin of a document that is repeated on every page or every other page, such as document titles or the date.

- **Hidden Slides**

  Hidden slides do not automatically appear in a presentation. You must prompt them by using a simple keystroke or menu option.
Legend

A legend is a box that contains entries and keys that help identify the data series in a chart.

Legend Key

The legend key is the symbol that appears next to the legend text that shows a sample of each data series indicator on the chart.

Legend Text

Legend text is the text that appears in a legend that identifies the data series on the chart.

Line Chart

Line charts show trends or changes in data over a period of time and at even intervals.

Linking Slides

Linking slides provides a way to make one presentation suit different audiences. Linking allows you to link a slide or presentation to the current presentation. You can then choose to run the presentation with or without the linked slide(s).

Master Text

The Master text (Object Area for AutoLayouts) is the placeholder that contains the formatting for the main text on the Slide Master. This placeholder contains the font, color, size, line spacing, and alignment settings of the main text as well as the text's attributes, shape, and placement.

Master Title

The Master title (Title Area for AutoLayouts) is the placeholder that holds the formatting for the titles on a Slide Master. This placeholder contains the font, color, size, alignment, and line spacing settings of the slides titles as well as the text's attributes, shape, and placement.

Monotype Sorts

Monotype Sorts is a TrueType font that provides a variety of bullet styles. The Monotype Sorts font appears on most computers on which Windows has been installed.
Mouse Pointer

The mouse pointer is the arrow that shows up on the screen and is directed by the mouse. The mouse pointer often changes appearance depending on where it is positioned or what action you are taking.

New

Use the New command to create a new presentation. The New command allows you to create a presentation from scratch, or it offers a variety of designs and formats that can be used as a starting point.

Notes Pages

Notes Pages contain a reduced image of a slide as well as an area to include speakers notes.

Office Assistant

The Office Assistant appears on all PowerPoint screens until you close it and can be used to get help and tips on using PowerPoint.

Online Presentation

An online presentation is an electronic slide show that is run on or projected from a computer.

Options

Options on the Tools menu allows you to set your preferences for PowerPoint functions, such as the maximum number of undos, smart quotes, and viewing non-printing characters.

Order

Use the Order command to rearrange the order of objects on a slide.

Organization Boxes

Organization boxes are the boxes within an Organization chart that contain the name and job information for each position.

Organization Chart

An organization chart is a diagram or map that shows the hierarchy of a group or business. It usually shows a person's name, and the position that person holds within the group or business.
➤ **Outline view**

Allows you to work with slide titles and main text without being distracted by background colors and graphics. You can see most of the text in your presentation at a glance instead of scrolling from slide to slide. You can also rearrange the order and organization of your slides and text, and make formatting changes.

➤ **Outlining Toolbar**

The Outlining toolbar is available in Outline view by default, and is located on the left side of the window. The Outlining toolbar has buttons that provide quick access to outlining features such as indenting and text relocation.

➤ **Pack And Go**

Pack And Go "wraps up" your presentations and all of its elements, along with the PowerPoint Viewer, into a Pack and Go executable file so you can load and view it on any machine.

➤ **Pack And Go Wizard**

The Pack and Go Wizard is a series of dialog boxes that walks you through packaging a presentation so you can show it on other computers.

➤ **Pen Tool**

Use the pen tool to mark on the slides during a presentation.

➤ **Picture**

Pictures can be anything from scanned photographs to line art images to artwork from compact discs.

➤ **Picture Toolbar**

Use the Picture toolbar to quickly make changes to the selected image. The Picture toolbar appears as a floating toolbar whenever you have an image selected.

➤ **Pie Chart**

Pie charts show the proportions of parts to a whole.

➤ **Placeholders**

Placeholders are predefined areas on Master slides and AutoLayouts that designate where specific objects or text should be placed.
- **Placement Line**
  
  The placement line appears in Outline view as you drag a slide icon to a new location. The line is used to make placement easier.

- **PowerPoint Viewer**
  
  The PowerPoint Viewer is a program that comes with PowerPoint, but it allows you to view presentations without having PowerPoint installed.

- **Presentation**
  
  A presentation is a collection of slides, handouts, speaker's notes, and an outline, all combined into a file that can be printed onto transparencies or projected from a computer.

- **Presentation Designs**
  
  The Presentation Designs card in the New Presentation dialog box is a collection of templates that helps you determine the color scheme, fonts, and other design features of your presentation.

- **Presentation Templates File**
  
  A Presentation Templates file is any presentation background that is saved as a template. You can modify existing templates or create new templates from scratch, then save them as a Presentation Template.

- **Preset Animations**
  
  Use PowerPoint's preset animation effects to quickly apply interesting animation effects to your slide show.

- **Print Range**
  
  The Print Range option in the Print dialog box allows you to specify what pages of a document you want to print.

- **Print What**
  
  The Print What option in the Print dialog box allows you to specify in what format you want the document to print.

- **Radar Chart**
  
  Radar charts show changes or frequencies of series of data relative to a center point and relative to each other.
➢ **Regular Shapes**

Regular shapes refer to perfectly proportioned shapes, such as circles and squares, that can be inscribed within a square, or any shape with equal sides or equal distance from the center.

➢ **Rehearsal Timer**

The Rehearsal Timer allows you to set timings for your slides so you can run the presentation on its own.

➢ **Replace**

Use Replace on the Edit menu to search for and replace specified text.

➢ **Resize Handles**

Resize handles are small, solid boxes that appear in the border of a selected object. The resize handles are used to change the size of the selected object.

➢ **Rows**

Rows are the horizontal divisions of a datasheet that are identified by numbers.

➢ **Ruler Guides**

The ruler guides are the lines on the ruler that move according to the pointer position. These lines help position the location of the pointer.

➢ **Rulers**

Use rulers to help align and size objects on your slide.

➢ **Slide Navigator**

The Slide Navigator allows you to go to any slide in your presentation while in Slide view.

➢ **Slide Show Menu Icon**

Click the Slide Show Menu icon to open a menu with options to apply in Slide Show view.
Slide Show View

Slide Show View shows how a presentation will look when you run it. This allows you to do a test run and even create timed presentations.

Slide Sorter Toolbar

The Slide Sorter toolbar is available only in Slide Sorter view, and allows quick access to special PowerPoint effects such as transitions, builds, rehearse timing, and hide slides.

Slide Sorter View

Slide Sorter View displays a reduced image of all the slides in a grid-like fashion. This view makes it easier to rearrange the slides in a presentation and add transitions and special effects.

Slide View

Slide View allows you to work on one slide at a time. While in Slide View, you can add any element to a slide, including text, graphics, shapes, and graphs.

Slides

Slides are the individual pages of your presentation. Slides can be designed with different titles, graphics, text, and much more.

Speaker's Notes

Speaker's Notes are pages with a copy of a slide on top and space below it for taking notes.

Standard Toolbar

The Standard toolbar is located beneath the menu bar, and contains buttons that provide quick access to commonly used tools and options for the application.

Status Bar

The status bar is the area at the bottom of a window that provides messages that describe what you are seeing and doing in the presentation as you work.

Subordinate

A subordinate is someone in a lower rank or position.
Supplementary Application

A supplementary application is an application that can be opened and used within PowerPoint. Microsoft Graph, Microsoft Organization Chart, and Microsoft WordArt are examples of supplementary applications.

Shade Styles

Shading an object in PowerPoint creates a gradient effect -- a gradual shift from one color to another. All objects in PowerPoint can be filled with a shaded color.

Shading

Shading is a modification of a color that is made by adding complementary colors or small amounts of black.

Shading Fill

Shading Fill sets the overall style or direction of the shading.

Shadow

Use the Shadow effect to emphasize text. It produces a drop-shadow behind the text.

Slide Color Scheme

The Slide Color Scheme option on the Format menu lets you change colors in a color scheme, or select new colors for a single slide or an entire presentation.

Slide Icon

A slide icon is the graphical representation of a slide in Outline View that appears where each slide begins. The slide icon also displays small shapes if any graphics or other objects exist on the slide.

Slide Master

The Slide Master is the slide that holds the formatting for the title, the text, and any background items that appear on the slides. Any text styles or graphics that appear on the Slide Master will appear on all of the slides in a presentation.

Select

In order to work with an object, you must first select or activate it. One way to select an object by clicking it once with the mouse.
- **Selection Box**

A selection box appears around a text box when it is selected on a PowerPoint slide. It includes the selection handles. It also appears around items as you click-and-drag the mouse pointer around a group of objects you want to select.

- **Selection Handles**

Selection handles, which look like small squares, appear on objects when they are selected on a PowerPoint slide. They can be used to change the size of the object.

- **Send Backward**

The Send Backward option on the Order submenu allows you to send objects back one level or layer of a slide at a time.

- **Send To Back**

The Send to Back option on the Order submenu allows you to send objects all the way to the back level or layer of a slide.

- **Shade Styles**

Shading an object in PowerPoint creates a gradient effect -- a gradual shift from one color to another. All objects in PowerPoint can be filled with a shaded color.

- **Shading**

Shading is a modification of a color that is made by adding complementary colors or small amounts of black.

- **Shading Fill**

Shading Fill sets the overall style or direction of the shading.

- **Shadow**

Use the Shadow effect to emphasize text. It produces a drop-shadow behind the text.

- **Slide Color Scheme**

The Slide Color Scheme option on the Format menu lets you change colors in a color scheme, or select new colors for a single slide or an entire presentation.
- **Slide Icon**

   A slide icon is the graphical representation of a slide in Outline View that appears where each slide begins. The slide icon also displays small shapes if any graphics or other objects exist on the slide.

- **Slide Master**

   The Slide Master is the slide that holds the formatting for the title, the text, and any background items that appear on the slides. Any text styles or graphics that appear on the Slide Master will appear on all of the slides in a presentation.

- **Slide Navigator**

   The Slide Navigator allows you to go to any slide in your presentation while in Slide view.

- **Slide Show Menu Icon**

   Click the Slide Show Menu icon to open a menu with options to apply in Slide Show view.

- **Slide Show View**

   Slide Show View shows how a presentation will look when you run it. This allows you to do a test run and even create timed presentations.

- **Slide Sorter Toolbar**

   The Slide Sorter toolbar is available only in Slide Sorter view, and allows quick access to special PowerPoint effects such as transitions, builds, rehearse timing, and hide slides.

- **Slide Sorter View**

   Slide Sorter View displays a reduced image of all the slides in a grid-like fashion. This view makes it easier to rearrange the slides in a presentation and add transitions and special effects.

- **Slide View**

   Slide View allows you to work on one slide at a time. While in Slide View, you can add any element to a slide, including text, graphics, shapes, and graphs.

- **Slides**

   Slides are the individual pages of your presentation. Slides can be designed with different titles, graphics, text, and much more.
- **Speaker's Notes**

  Speaker's Notes are pages with a copy of a slide on top and space below it for taking notes.

- **Standard Toolbar**

  The Standard toolbar is located beneath the menu bar, and contains buttons that provide quick access to commonly used tools and options for the application.

- **Status Bar**

  The status bar is the area at the bottom of a window that provides messages that describe what you are seeing and doing in the presentation as you work.

- **Subordinate**

  A subordinate is someone in a lower rank or position.

- **Supplementary Application**

  A supplementary application is an application that can be opened and used within PowerPoint. Microsoft Graph, Microsoft Organization Chart, and Microsoft WordArt are examples of supplementary applications.

- **Template**

  A template is a slide or presentation that provides a predefined format and color scheme that can be applied to another presentation. PowerPoint provides more than 100 professionally designed templates, or you can use an existing presentation as a template.

- **Thumbnail**

  A thumbnail is a small view of the current slide. It appears in several different PowerPoint screens, including Outline view.

- **Thumbnail Prints**

  Thumbnail prints are small printed versions of slides. You can print 2, 3, or 6 thumbnails on a single page.

- **Title Case**

  Title case is when each major word in the text starts with a capital letter.

- **Title Master**

  The Title Master holds the master format for title slides in a presentation.
Title Slide

The Title slide is an AutoLayout that provides placeholders for a title and a subtitle for a presentation.

Transition

A transition is an effect that can be run between slides to signal a shift from one slide to the next.

Transition Icon

In Slide Sorter view, a transition icon appears under every slide that has a transition applied to it.

TrueType Fonts

TrueType fonts are scaled to fit your presentation so they always present a smooth, clear image. They are designed to be used on any printer and in any type size.

Ungrouping Objects

Ungrouping objects allows you to work with each part of a grouped object individually.

Variant

Variants are different shading orders of a selected style.

WordArt

WordArt is a supplementary application that can be used to manipulate text into shapes. For instance, you can make a phrase or sentence form a circle.

XY (Scatter) Chart

XY (scatter) charts show the relationship between the numeric values in several series of data.

1.3. Programming Terms

1.3.1. General Terms

Statements

Most programming languages have the concept of a statement. A statement is a command that the programmer gives to the computer.
➢ **Syntax**

All computer languages have syntax, rules to create proper statements, just like natural languages do. For example, most sentences are ended with a full stop or a period. Likewise it is common for statements in source code to be ended with a semicolon, but many languages do not have this requirement so it is important to know the syntax of the language you are programming in.

➢ **Semantics**

Semantics refers to the meaning or logic of a computer program. Two syntactically correct statements can make perfect sense by themselves, but they may not make sense when placed next to each other. Sometimes these flaws in logic can be detected by the compiler, what is known as a compile-time error, but typically these errors surface when the program is executed, known as run-time errors.

➢ **Compiler**

In programming, the software translating a source code written in a programming language to another language are called compiler.

➢ **Programming Language**

No matter it is for general use or private use all application ans system software are written with programming languages. A programming language is a group of every kind of symbol, character and rules which enables humans make computers do various processes. Whether it is on general or special purpose application and system softwares are written in programming languages. A programming language is a group of all kinds of symbol, characters and rules that enables people perform various tasks on PC’s.

➢ **Variable**

Variables represents the storage areas the data is stored in a programming language. Each variable defined is allocated a space from the memory field.

➢ **Data**

The name given to all kinds of information in programming.

➢ **Constant**

The definitions used for the data which will remain fixed during the program.

➢ **Operator**

The symbols used to compare or perform mathematical operations.
- **Decision Control**
  
  It is used for desired conditions supposed to occur under certain conditions at some point while writing the program.

- **Loop**
  
  Loops are the command blocks that carry out certain tasks over and over in a program.

- **Array**
  
  Array is a collection of data which have the same type and the common name referred to.

- **Method**
  
  The sub-programs designed to fulfill a particular task for use anywhere in the program is called a method.

- **Input**
  
  In programming the name given to any stimulating information or event entered or written in a program, in other word they are the acts to arouse action.
APPLICATION ACTIVITY

Prepare a hardware crossword puzzle consisting at least ten words using the example below.

L I C E N S E
N E T
S T U P
t e t t

Steps Of Process | Suggestions
---|---
➢ Determine the terms that you will use in the crossword puzzle. | ➢ Pay attention to use common letters in words.
➢ Put the terms according to the crossword puzzle. | ➢ Coinciding common letters in the crossword puzzle is enough.
➢ Add a number coming to the first letters of the terms. | ➢ If you continue in specific order, you can prevent confusion.
➢ Write corresponding definitions of terms into the numbers. | ➢ If you continue in specific order, you can prevent confusion.
➢ Delete the terms on the crossword puzzle. | ➢ Pay attention not to leave empty spaces on the crossword puzzle.
CHECKLIST

If you have behaviors listed below, evaluate yourself putting (X) in “Yes” box for your earned skills within the scope of this activity otherwise put (X) in “No” box.

<table>
<thead>
<tr>
<th>Evaluation Criteria</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Can you define general software terms in english?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Can you define packet program terms in english?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Can you define programming terms in english?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

EVALUATION

Please review your "No" answers in the form at the end of the evaluation. If you do not find yourself enough, repeat learning activity. If you give all your answers "Yes" to all questions, pass to the "Measuring and Evaluation".
Read the questions below carefully and fill in the blanks.

1) ..................is a software communicating with the user in a computer system.

2) The central location for all your operating system configuration needs is called ..................

3) The process of combining the broken data in a unit is called ..................

4) .................. saves TrueType fonts in a presentation so text will be properly displayed on other computers.

5) A Presentation Templates file is any .................. that is saved as a template.

6) The software translating a source code written in a programming language to another language are called ..................

7) When there is an insufficient storage you see the compiler error ..................

8) The storage areas the data is stored in a programming language are represented by ..................

EVALUATION

Please compare the answers with the answer key. If you have wrong answers, you need to review the Learning Activity. If you give right answers to all questions, pass to the next learning activity.
AIM

Students will be able to acquire the basic vocational terms about internet according to the technique.

RESEARCH

- Research the basic definitions and terms about internet.
- Prepare a report of your findings.
- Make a presentation to your teacher and your friends in your classroom.

2. INTERNET TERMS

2.1. General Terms

- **Address**

  An individualized name (or number) identifying a computer user or computer. Used in network communications for the transmission of messages for a particular person or machine.

- **Bookmark**

  Most Web browsers give you an option of adding a URL to a list. By doing this, you can store the linking information (the URL) to any Web pages you plan to revisit.

- **Browser (Web browser)**

  A software application (either text-based or graphical) that lets you browse (surf) the World Wide Web.

- **Cache (Pronounced “cash”)**

  A region on the computer memory where frequently accessed data can be stored for fast access.
Client/Server

In web terms: The communication and separation of workload between a web client and a web server.

Cookie

Small bits of data that a Web page asks a browser to store on a user’s computer, either in RAM or on the hard drive.

Domain Name System (DNS)

The unique name of a collection of computers connected to Networks such as the Internet.

Download

To receive a file sent from another computer via modem.

DSL (Digital Subscriber Line)

DSL circuit is much faster than a regular phone line. Currently DSL is not available in all cities or parts of cities.

Encryption

The process of scrambling a message so that a key, held only by authorized recipients, is needed to unscramble and read the message.

Firewalls

Special computers that are set up on a network to prevent intruders from stealing or destroying confidential files.

Freeware

Noncopyrighted software made available free for public use by the author.

FTP (File Transfer Protocol)

The process of transferring files or programs from one computer to another. An FTP site is a computer on the Internet that stores files and provides access to them.

Home page

An introductory WWW page or Web server at a Web site that provides hyperlinks to other Web pages.
- **HTML (HyperText Markup Language)**

  The computer language used to create hypertext documents. A system of marking up, or tagging, a document so it can be published on the World Wide Web.

- **HTTP (HyperText Transfer Protocol)**

  The client-server protocol upon which the World Wide Web is based.

- **HTTPS (HyperText Transfer Protocol Security)**

  It is the protocol for the World Wide Web that provides safe data transmission by encrypting and decrypting information sent over the Internet.

- **Hyperlink, hypertext**

  A link within one document connected to other documents, other places within the same document, pictures, or HTML pages. Think of a hyperlink as an invitation to visit another place. A simple click on the link will take you there.

- **Internet**

  The worldwide network of networks based on the TCP/IP protocol. A noncommercial, self-governing network devoted mostly to communication and research with roughly 66 million users worldwide.

- **Internet Service Providers (ISP)**

  An organization that lets users dial into its computers to connect to its Internet link for a fee. ISPs generally provide an Internet connection and an electronic mail address. Some providers also include World Wide Web browsing software.

- **Intranet**

  Internal networks, based on Internet technology, designed to connect the members of a specific group or single company (a closed-user group).

- **IP (Internet Protocol)**

  Main protocol upon which the Internet is based.

- **ISDN (Integrated Services Digital Network)**

  Telecommunications network that allows for digital voice, video, and data transmissions.
- **Local Area Network (LAN)**
  
  A network of connected computers and/or servers that are physically located near each other.

- **Login, logon**
  
  The process of identifying yourself to your computer or an online service. The initial identification procedure to gain access to a system as a legitimate user. The usual requirements are a valid user name (or user ID) and password.

- **Multimedia**
  
  Documents or platforms that combine different kinds of data (text, video, graphics, audio).

- **Netiquette**
  
  Guidelines to good manners on the Internet; for example, don’t flame other users, don’t leave your caps lock key on (that’s like yelling), etc.

- **Newsgroup**
  
  Collection of information and users who get together to communicate about one particular subject.

- **Online**
  
  Refers to the successful connection with another computer via telephone lines or through a network.

- **Script**
  
  Also known as calling script. A record of keystrokes and commands that can be played back in order to automate routine tasks, such as logging on to an online service.

- **Search engine**
  
  A WWW site that serves as an index to other sites on the Web.

- **Server**
  
  A computer (or service) that provides information or a service to other computers on a network.
Shareware

Software that is sold by individuals or companies for a nominal fee. Typically the software is downloaded and tried out before buying and registering it.

Signature

A three- or four-line message, used to identify the sender of an e-mail message or Usenet article.

TCP/IP (Transmission Control Protocol/Internet Protocol)

A set of instructions that dictates how packets of information are sent across multiple networks. This includes SLIP and PPP. Also included is a built-in error-checking capability.

Upload

To send or transmit a file from one computer to another via modem.

URL (Universal Resource Locator)

A Web site’s address. An example is: http://www.extension.iastate.edu (ISU Extension’s home page).

Usenet

Refers mostly to the newsgroups, but also to e-mail. Usenet travels on the Internet, but also over modems and satellites.

Username, user-id

An address that designates a personal account on a large computer. For example, in jsmith@xyz.com, “jsmith” is the user-id.

Web server

A computer that is connected to the Internet that stores and manages Web documents. A Web server handles requests from other computers and delivers requested Web documents.

Web site

A group of related pages, images, and files on a Web server.

WWW (World Wide Web)

One of several features of the Internet. It contains graphics, video, audio, text, and much, much more.
2.2. E-mail Terms

- **Above the fold**

  The top part of an email message that is visible to the recipient without the need for scrolling. The term originally comes from print and refers to the top half of a folded newspaper.

- **Attachment**

  An audio, video or other data file that is attached to an email message.

- **Autoresponder**

  A computer program that automatically responds with a prewritten message to anyone who sends an email message to a particular email address or uses an online feedback form.

- **Authentication**

  A term that refers to standards, such as Sender ID, SPF and DomainKeys/DKIM, that serve to identify that an email is really sent from the domain name and individual listed as the sender. Authentication standards are used to fight spam and spoofing.

- **Blacklist**

  A list containing email addresses or IP addresses of suspected spammers. Blacklists are sometimes used to reject incoming mail at the server level before the email reaches the recipient.

- **Block**

  An action by an Internet Service Provider to prevent email messages from being forwarded to the end recipient.

- **Bounces**

  Email messages that fail to reach their intended destination. "Hard" bounces are caused by invalid email addresses, whereas "soft" bounces are due to temporary conditions, such as overloaded inboxes.

- **Challenge-Response**

  An authentication method that requires a human to respond to an email challenge message before the original email that triggered the challenge is delivered to the recipient. This method is sometimes used to cut down on spam since it requires an action by a human sender.
- **Click-through tracking**

  The process of tracking how many recipients clicked on a particular link in an email message. This is commonly done to measure the success of email marketing campaigns.

- **Discussion group**

  An email list community where members can obtain and share information. Every member can write to the list, and in doing so, everyone subscribed to the list will receive a copy of the message.

- **Email**

  Email allows you to send and receive text, HTML, images and other data files over the Internet. Email is one of the most popular online activities and has become a vital tool for electronic commerce.

- **Email bounces**

  Email messages that fail to reach their intended destination. "Hard" bounces are caused by invalid email addresses, whereas "soft" bounces are due to temporary conditions, such as overloaded inboxes.

- **Email client**

  The software that recipients use to read email. Some email clients have better support for HTML email than others.

- **Email header**

  The section of an email message that contains the sender's and recipient's email addresses as well as the routing information.

- **False positive**

  A legitimate email message that is mistakenly rejected or filtered by a spam filter.

- **IMAP**

  Internet Message Access Protocol – A protocol used to retrieve email messages. Most email clients use either the IMAP or the POP protocol.

- **Merge-purge**

  The act of removing duplicate email addresses from a coalesced list that is composed of two or more existing lists.
- **MIME**

  Multi-Purpose Internet Mail Extensions – An extension of the original Internet email standard that allows users to exchange text, audio or visual files.

- **Multipart/alternative**

  A message format that includes both text and HTML versions. Recipients can then open the message in their preferred format.

- **Personalization**

  The insertion of personal greetings in email messages (for instance "Dear John" rather than the generic "Dear Customer"). Personalization requires email list management software that allows for so called mail-merge operations.

- **Plain text**

  Text in an email message that contains no formatting elements.

- **POP**

  Post Office Protocol – A protocol used to retrieve email from a mail server. Most email clients use either the POP or the newer IMAP protocol.

- **Sender ID**

  Sender ID is an authentication protocol used to verify that the originating IP address is authorized to send email for the domain name declared in the visible "From" or "Sender" lines of the email message. Sender ID is used to prevent spoofing and to identify messages with visible domain names that have been forged.

- **SMTP**

  Simple Mail Transfer Protocol – A protocol used to send email on the Internet. SMTP is a set of rules regarding the interaction between a program sending email and a program receiving email.

- **Soft bounces**

  Email messages that cannot be delivered to the recipient because of a temporary error, such as a full mailbox.

- **Spam**

  (Also known as unsolicited commercial email) – Unwanted, unsolicited junk email sent to a large number of recipients.
➢ **Subject line**

The part of an email message where senders can type what the email message is about. Subject lines are considered important by email marketers because they can often influence whether a recipient will open an email message.

➢ **Whitelist**

A list of pre-authorized email addresses from which email messages can be delivered regardless of spam filters.

➢ **Worm**

Malicious code that is often spread through an executable attachment in an email message.
APPLICATION ACTIVITY

Prepare a hardware crossword puzzle consisting at least ten words using the example below.

```
B
R
O
F I R E W A L L S
S A E N
R
```

**Steps Of Process** | **Suggestions**
---|---
- Determine the terms that you will use in the crossword puzzle. | - Pay attention to use common letters in words.  
- Put the terms according to the crossword puzzle. | - Coinciding common letters in the crossword puzzle is enough. 
- Add a number coming to the first letters of the terms. | - If you continue in specific order, you can prevent confusion. 
- Write corresponding definitions of terms into the numbers. | - If you continue in specific order, you can prevent confusion. 
- Delete the terms on the crossword puzzle. | - Pay attention not to leave empty spaces on the crossword puzzle.
CHECKLIST

If you have behaviors listed below, evaluate yourself putting (X) in “Yes” box for your earned skills within the scope of this activity otherwise put (X) in “No” box.

<table>
<thead>
<tr>
<th>Evaluation Criteria</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>➢ Can you define general General terms for Internet in english?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>➢ Can you define general E mail terms in english?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

EVALUATION

Please review your "No" answers in the form at the end of the evaluation. If you do not find yourself enough, repeat learning activity. If you give all your answers "Yes" to all questions, pass to the "Measuring and Evaluation".
Adress is an individualized name (or number) identifying a computer user or computer  

1. ( ) Freeware software is Copyrighted software made available free for public use by the author.  
2. ( ) Software that is sold by individuals or companies for a nominal fee is called shareware.  
3. ( ) DSL circuit is much slower than a regular phone line.  
4. ( ) Unwanted, unsolicited junk emails sent to a large number of recipients are called spam.  
5. ( ) A set of instructions that dictates how packets of information are sent across multiple Networks are called DNS.  
6. ( ) A list containing email addresses or IP addresses of suspected spammers is called whitelist.  
7. ( ) The process of transferring files or programs from one computer to another is called HTML.  
8. ( ) Main protocol upon which the Internet is based is called IP.  

**EVALUATION**  

Please compare the answers with the answer key. If you have wrong answers, you need to review the Learning Activity. If you give right answers to all questions, pass to the next learning activity.
AIM

Students will be able to acquire the basic vocational terms about network terms according to the technique.

RESEARCH

➢ Research the basic definitions and terms about network.
➢ Prepare a report of your findings.
➢ Make a presentation to your teacher and your friends in your classroom.

3. NETWORK TERMS

3.1. General Definitions

➢ Network

A structure that enables software and hardware being shared through several computers connected to each other.

➢ Hosting

Hosting in the word means “housing”. A service that allows customers to place their own content on the public Internet's World Wide Web according to the defined domain names.

➢ Domain

Domain which provides ease on access while entering the addresses is the alphabetic and more streamlined version of the numeric system so-called IP address that enables the computers to connect each other.

➢ Server

The server computers are the computers those are able to serve many users for hosting simultaneously which have advanced hardware features.
➤ **Client**

All types of user computers that uses the web sites. They may called the computers performing out of the server.

➤ **Topoloji**

Topology is a term that defines how computers connect each other.

➤ **LAN (Local Area Network)**

It is a variant of network that certain number of computers created in a particular area. Local area Networks consist of computers, network interface cards, network cables, network traffic control devices and other peripheral devices.

➤ **MAN (Metropolitan Area Network)**

The network variant that is resulted by the increase in the number of users on the network and the network expansion in terms of the area is called wide area.

➤ **WAN (Wide Area Network)**

They are the wide networks formed by local Networks that are away far from each other.

➤ **Wireless**

Describes any computing device that can access a network without a wired connection.

➤ **WLAN (Wireless Local Area Network)**

Wireless Local Area Network Enables fast data transmission through a wireless connection particularly suitable for organisations such as hospitals and schools as well as businesses.

➤ **VPN (Virtual Private Network)**

A private network that utilizes parts of the public telecommunications network VPNs send encrypted data through the public network to ensure the security of transactions.

➤ **ADSL**

ADSL is the technology that enables rapid transfer of digital information through regular telephone cables (the line is asymmetrical because the connection is faster in one direction than the other).
- **Intranet**

  A private network inside a company or organization that uses the same kinds of software that you find on the public Internet, but which is only for internal use.

- **Extranet**

  A private computer network that uses Internet protocols and can be accessed by authorized individuals via the Internet.

- **DHCP (Dynamic Host Configuration Protocol)**

  Dynamic Host Configuration Protocol Dynamically assigns IP addresses to client stations located on a TCP/IP network at startup, and allows the addresses to be re-used when no longer needed.

- **Subnet**

  A portion of a network which shares a network address in which each component is identified by a subnet number.

- **Subnet Mask**

  A subnet mask is a way of telling your computer or router what network addresses it can consider local and which are remote.

- **Static IP**

  It is configuration of IP manually.

- **Dynamic IP**

  IP that is Automatically assigned by DHCP (dynamic host configuration protocol).
3.2. Network Hardware Components

- **NIC (Network Interface Card)**
  
  Hardware that you insert in a computer to connect a computer to a network.

  ![Network Interface Card](image1)

  Picture 3.1: Network Interface Card

- **Hub**
  
  A hub is a network device that connects multiple computers on a LAN so they can communicate with one another, the rest of the network, and the Internet. All users connected to a hub share the available network bandwidth/ports.

  ![Hub](image2)

  Picture 3.2: Hub

- **Switch**
  
  A networking device connecting multiple wires, allowing them to communicate simultaneously, when possible. Compare to the less efficient hub device that solely duplicates network packets to each wire.

  ![Switch](image3)

  Picture 3.3: Switch
Router

Hardware and software used to interconnect networks, directing traffic from one network to another (LAN TO LAN or LAN TO WAN)

Modem

A device that encodes digital computer signals into analog/analogue telephone signals and vice versa and allows computers to communicate over a phone line.

Access Point

A device, such as a WLAN or Internet modem, that permits wireless devices to connect to a network.

Repeater

A device used in a network to strengthen a weak signal as it is passed along the network cable because of any reason and send it back to the user.
APPLICATION ACTIVITY

Prepare a hardware crossword puzzle consisting at least ten words using the example below.

```
C  L  I
N  E  T  W  O  R  K
N  L
T  A
N
```

<table>
<thead>
<tr>
<th>Steps Of Process</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>➢ Determine the terms that you will use in the crossword puzzle.</td>
<td>➢ Pay attention to use common letters in words.</td>
</tr>
<tr>
<td>➢ Put the terms according to the crossword puzzle.</td>
<td>➢ Coinciding common letters in the crossword puzzle is enough.</td>
</tr>
<tr>
<td>➢ Add a number coming to the first letters of the terms.</td>
<td>➢ If you continue in specific order, you can prevent confusion.</td>
</tr>
<tr>
<td>➢ Write corresponding definitions of terms into the numbers.</td>
<td>➢ If you continue in specific order, you can prevent confusion.</td>
</tr>
<tr>
<td>➢ Delete the terms on the crossword puzzle.</td>
<td>➢ Pay attention not to leave empty spaces on the crossword puzzle.</td>
</tr>
</tbody>
</table>
CHECKLIST

If you have behaviors listed below, evaluate yourself putting (X) in “Yes” box for your earned skills within the scope of this activity otherwise put (X) in “No” box.

<table>
<thead>
<tr>
<th>Evaluation Criteria</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>➢ Can you define general network general terms in english?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>➢ Can you define general network hardware components in english?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

EVALUATION

Please review your "No" answers in the form at the end of the evaluation. If you do not find yourself enough, repeat learning activity. If you give all your answers "Yes" to all questions, pass to the "Measuring and Evaluation".
Write “True” or “False” in parentheses if the sentences below correct or incorrect.

1. ( ) All types of user computers that uses the web sites are called client.
2. ( ) Telecommunications network that allows for digital voice, video, and data transmissions are called LAN.
3. ( ) A network of connected computers and/or servers that are physically located near each other is called LAN.
4. ( ) VPN is the technology that enables rapid transfer of digital information through regular telephone cables.
5. ( ) A hub is a network device that connects multiple computers on a LAN so they can communicate with one another.
6. ( ) ADSL is a device that encodes digital computer signals into analog/analogue telephone signals and vice versa and allows computers to communicate over a phone line.
7. ( ) Access point is a device, such as a WLAN or Internet modem, that permits wireless devices to connect to a network.
8. ( ) Static IP is a way of telling your computer or router what network addresses it can consider local and which are remote.

EVALUATION

Please compare the answers with the answer key. If you have wrong answers, you need to review the Learning Activity. If you give right answers to all questions, pass to the next learning activity.
Read the questions carefully and choose the correct option.

1. The variations of a software announced in different periods is called…
   A) Version  
   B) Driver  
   C) Partition  
   D) Spam

2. Which of the following provides installation, display and management of all devices connected to PC.
   A) CD ROM  
   B) Device Manager  
   C) Control panel  
   D) Family Safety

3. Which of the following is the output from a computer that you can touch?
   A) Hardcopy  
   B) Softcopy  
   C) Footer  
   D) Margins

4. Which of the following displays only the rows in a list that satisfy the conditions you specify?
   A) Name box  
   B) Merged cell  
   C) Filter  
   D) Functions

5. Which of the following contain related information or data to be analyzed?
   A) Data  
   B) Data labels  
   C) Data series  
   D) Datasheets

6. Which of the following contains entries and keys that help identify the data series in a chart.
   A) Legendtext  
   B) Legend key  
   C) Legend  
   D) PCI
7. Which of the following is the name given to The computer language used to create hypertext documents?
   A) HTTP
   B) HTML
   C) HTTPS
   D) LAN

8. Which of the following compiler error occurs when necessary variable identification has not been executed.
   A) Type mismatch
   B) Unknown identifier
   C) Invalid file name
   D) Identifier expected

9. Which of the following compiler error occurs when there is an error in sequence of characters that is intended to be written?
   A) Error in statement
   B) Syntax error
   C) Invalid qualifier
   D) Error in real constant

10. Which of the following compiler error occurs when same variable has been identified in 2 different types?
    A) Duplicate identifier
    B) Variable identifier expected
    C) Type mismatch
    D) Invalid file type

**EVALUATION**

Please compare the answers with the answer key. If you have wrong answers, you need to review the Learning Activity. If you give right answers to all questions, please contact your teacher and pass to the next module.
### Answer Key

#### Learning Activity - 1

<table>
<thead>
<tr>
<th></th>
<th>Operating system</th>
<th>Control panel</th>
<th>Defragmentation</th>
<th>Font embedding</th>
<th>Presentation background</th>
<th>Compiler</th>
<th>Out of memory</th>
<th>Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Learning Activity - 2

<table>
<thead>
<tr>
<th></th>
<th>False</th>
<th>True</th>
<th>False</th>
<th>True</th>
<th>False</th>
<th>False</th>
<th>False</th>
<th>False</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Learning Activity - 3

<table>
<thead>
<tr>
<th></th>
<th>True</th>
<th>False</th>
<th>True</th>
<th>False</th>
<th>True</th>
<th>False</th>
<th>True</th>
<th>True</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## MODULE EVALUATION

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
</tr>
<tr>
<td>2</td>
<td>B</td>
</tr>
<tr>
<td>3</td>
<td>A</td>
</tr>
<tr>
<td>4</td>
<td>C</td>
</tr>
<tr>
<td>5</td>
<td>D</td>
</tr>
<tr>
<td>6</td>
<td>C</td>
</tr>
<tr>
<td>7</td>
<td>B</td>
</tr>
<tr>
<td>8</td>
<td>D</td>
</tr>
<tr>
<td>9</td>
<td>B</td>
</tr>
<tr>
<td>10</td>
<td>A</td>
</tr>
</tbody>
</table>
RESOURCES

- PENG J, Communications and Networking, Sciyo (September 2010)
- FRANDSEN Torben L., Microsoft Office Word, BookBoon 2010
- FRANDSEN Torben L., Microsoft Office Powerpoint, BookBoon 2010
- FRANDSEN Torben L., Microsoft Office Excel, BookBoon 2010